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I.  Introduction

A.  Instrument Function Overview

The MS3500L data logger is designed to provide a continuous record of  corrosive  activity  in  remote
locations  that  are infrequently visited, such as cross-country pipelines, and unmanned production
platforms.  However,  this unit finds equal application in locations that are inconvenient or difficult to
access on a regular basis, such as refinery overheads, and flue-gas stacks.

The MS3500L is completely self-contained with the onboard battery system supplying the total power
requirement for operation.  It can be used with any of Metal Samples’ LPR probes, or those of all other
major manufacturers.  Once in place, it will automatically read the probe at customer-selected intervals
and store the resulting data in the unit’s onboard memory.   The onboard memory will collect up to
3,000 data points before data download is required.  With practical data collection intervals (1 - 2
hours), the unit may be unattended for several months between downloading operations.

An optical, infrared, RS232 communication link is provided for data download to either an IBM
compatible PC or Metal Samples’ MS1500L portable LPR data logger.   Downloaded data may be
analyzed, reviewed, or reported by conventional spreadsheet, database, or mathematical software
packages.

The  infrared  communication  link  is  an  integral  part  of  the intrinsically safe design of the MS3500L.
Optical instead of electrical, this unique feature permits data to be downloaded to an MS1500L while
still in the hazardous area.

Another unique feature of the MS3500L is the high level of onboard intelligence.  The two-line, 20-
character lcd allows visual review of all historical data in memory and reads directly as “total metal loss”
and/or “average corrosion rate”.   This is in contrast to other commercially available units that store and
display only the raw “resistance ratio” that requires additional manipulation to provide useful and
intelligible data.

The lcd screen, together with the 2-key membrane keypad, provides a user-friendly, interactive,
prompting system that is used for both system setup and data review.  This makes the MS3500L the
most advanced unit of its type on the market.

By adding a 4-20mA communication facility, the MS3500L becomes an MS3510L.  This allows
continuous transmission of data,  via a 4-20mA loop,  to a plant computer or central data logger,  for
integration with other real-time process parameters.  This data transmission can be accomplished
without disruption of the unit’s basic logging and data storage operations.  The 4-20mA loop extends
the capabilities of the unit to include conventional, in-plant, real-time data communication.

The MS3500L unit uses a stainless steel NEMA 4X (IP 66) enclosure, making it suitable for use in the
most extreme of outdoor conditions.
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B. Instrument Parts List

The MS3500L/MS3510L is supplied with the following accessories.

Part no. Qty. Description
ET0133   6 1.5V, AA Dry Cells (Installed)

ET0612   1 4-20ma Loop Connector (MS3510L Only)

IN1500L-3   1 Meter Prover

IN1500L-5   1 6 To 5 Pin Probe Adaptor

IN3500-2   1 Optilink Cable

IN3500-4   1 10 Ft. Probe Cable

IN3500-6   1 Serial Port Adaptor

IN3500L-2   1 Operations Manual

IN3500L-4   1 Galvanic Probe Adapter

Upon receipt of the instrument, the user should verify that the above listed accessories are included.
Any shortage should be reported immediately to:

Metal Samples
Phone: (256) 358-4202
Fax: (256) 358-4515
E-mail: msc@alspi.com

6-Pin
Male

5-Pin
Femaleemale

6-Pin
Male

6-Pin
Femaleemale
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II.  Installation

A. Enclosure & Mounting Details

The MS3500L enclosure is fabricated in carbon steel with a baked-on, high-build epoxy coating.  The
unit has a hinged door that is secured, when shut, by screw-down clamps that discourage unauthorized
tampering.  The enclosure is constructed to NEMA 4X (IP 66) weatherproof standards, making it
suitable for the most rigorous of outdoor environments.

The overall dimensions of the unit are 11½" (height), 9" (width), 4d" (depth), making it a convenient
size to mount even in the most confined of locations.   For the best results, the instrument should be
mounted within ten feet of the probe location. To facilitate this, the unit has a versatile mounting flange
with four .31" diameter, mounting holes.  Overall dimensions and mounting hole centers are shown in
Figure 1.

Figure 1.  MS3500L Dimensions
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B. Battery Installation

The MS3500L instrument uses six 1.5V, AA size batteries, connected in series, as a primary power
source.  While any AA size battery can be used, Duracell or Procell Type MN1500 or PC1500
batteries are required to meet the intrinsic safety certification requirements.  Since the MS3500L
operates in a low power consumption mode between readings, battery life will be a function of the
reading interval and measurement time cycle set by the user.   At the most frequent reading interval (1
per hour), a minimum battery life of four months is to be expected.  More practical intervals, such as
every 12 or 24 hours, will yield a battery life in excess of twelve months.  Generally, to avoid
unexpected power drains, batteries should be replaced once every six months.  In the instance of a low
reading interval (1 per 4 hours or less), three month battery replacement is advisable.

Batteries are mounted in the back of the MS3500L/MS3510L, behind the instrument screen and
keyboard panel.  The batteries are accessed by loosening the two thumbscrews on the right side of the
panel, then swinging the hinged panel open to the left.  Care should be used when opening and closing
the panel to ensure that the internal wiring is not pinched or damaged.  Once the panel is opened,
batteries can be inserted or removed from the spring-loaded retainer as shown below.

Note: Battery replacement should only be performed after removing the MS3500L from
hazardous locations.

Figure 2.  MS3500L Battery Installation
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C. 4-20mA Loop Installation

1. Electrical Connections
The MS3510L is available with a 4-20mA communication outlet that allows continuous, real-time 
integration of LPR corrosion data with other process parameters in the main plant computer.  The 
4-20mA outlet port is a 2-pin military connector (MIL 14S-9SF) on the base of the unit, marked 
4-20mA.  The mating connector for this outlet (ET0612) is supplied as part of the accessories for 
the MS3510L unit.  The positive lead of the communication loop should be connected to the “A” 
terminal of the ET0612 mating connector, and the negative lead to the “B”.  The loop can then be 
connected to the 4-20mA instrument outlet.

Corrosion Monitoring Systems
Metal Samples

PIN 'A' (+ CURRENT LOOP)
PIN 'B' (- CURRENT LOOP)

VIEW A-A
2-PIN MALE CONNECTOR

(VIEWED FROM SOLDER-SIDE)

A BA A

MS3510L Connections

PROBE 4-20 
mA

OPTI-LINK
DATA PORT

The loop should be powered by 10-24 VDC.  For hazardous applications, an appropriate Zener 
barrier should be installed in the loop, or power should be supplied from an intrinsically safe 
repeater power supply.  Typical hazardous installation is shown on page 38.

2. Output Scaling
The scale of the 4-20mA current loop depends on the measurement setting being used. The  
following table gives the scaling factors for each measurement type.

Measurement Type 4mA 20mA

2-Electrode 0 mpy 200 mpy

3-Electrode 0 mpy 150 mpy

Galvanic (Current) -999 µA +999 µA

Potential (Voltage) -999 mV +999 mV

5
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D. Probe-Instrument Connection

The MS3500L can be mounted directly onto an LPR probe.  However,  in  many  instances  it  is  either
inconvenient or undesirable to mount the instrument directly onto the probe.  For these circumstances a
IN3500-4, ten-foot, extension cable is provided.   The extension cable has integral connectors with a
guiding keyway to ensure correct pin alignment when attached.  The female connector mates with the
probe, or probe adaptor,  and the male connector mates with the central terminal on the base of the
MS3500L unit.

The length of the extension cable has been carefully determined so as to avoid excessive
signal noise. Longer extension cables should only be employed after consultation with Metal
Samples.

The extension cable provided will mate directly with any Metal Samples’ LPR probe or those of any
other major manufacturer, which use a standard six-pin connector.  For probes which use a five-pin
connector instead of a six-pin connector, the IN1500L-5 (6 to 5 pin adaptor) is used.

Figure 4.  Adapter Connection for 2-Electrode LPR Probe

The user may from time to time, encounter probes with a non-standard probe connection, especially if
the probes are of non-standard commercial variety.  To account for this possibility an IN1500L-4, flying
lead, cable adaptor is available.  This comprises a conventional instrument end connector, attached to a
cable with flying leads, terminated in alligator clips.  This allows for individual terminations to be made to
any non-conventional probe, providing the probe connector pin-out is known.  If the user is unfamiliar
with the pin-out on any particular probe, this can be established prior to probe installation by performing
a simple continuity check between the probe electrodes and the probe connector pins.
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UPLOAD TO PC
       (SAFE AREA ONLY)

UPLOAD
TO MS1500

MS1500 HANDHELD
DATA-LOGGER

OPTI-LINK CABLE

MS3500/MS3510
DATA-LOGGER

Ò

US
SIL ET D

REMOTE LPR DATA LOGGER/TRANSMITTER
MS3510L

MS3500 SERIAL
PORT ADAPTER

SERIAL TO USB
ADAPTER (OPTIONAL)

TO
COMPUTER

SERIAL
PORT

TO
COMPUTER

USB
PORT

Corrosion Monitoring Systems
Metal Samples

Corrosion Monitoring Systems
Metal Samples

LPR Data Logger

MS1500L

1 2 3
4 5 6
7 8 9

0

Exit Enter

Figure 5.  Data Download Connections

E. Data Download Connection
To download data from the MS3500L to a PC use the Optilink Cable and Serial Port Adaptor.

Note: Do NOT plug the phone jack on the end of the Optilink Cable directly into your PC's
modem.

If a serial port is unavailable on your PC and you wish to connect the MS3500L to your PC via a USB
port, you may use a serial to USB converter. This converter is not included with the instrument, but may
be purchased serparately at major electronics retailers.

To download data from the MS3500L to a MS1500L connect the Optilink Cable directly to the
MS1500L.

Detailed instructions of data downloading are given on p.16.
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III.  Setup and Operation
A. Main Menu Overview

Once the batteries are installed in the MS3500L/3510L, the instrument screen may be activated by
pressing either of the keys on the front panel. The company name “METAL SAMPLES” and software
version will appear, then after a few seconds will automatically change to the first of the function screens
that constitutes the main menu.

A series of nine function screens can be accessed simply by scrolling using KEY 1 on the instrument
keypad. Each of the nine function screens allows entry into a submenu to initiate an action such as
MEASURE PROBE or START DATA LOGGING; alternatively it allows input of data such as probe
identification or reading interval.

Each of the function screens and their submenus are fully explained later in the manual. The following
diagram shows the sequence of access to the twelve function screens:
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As explained, each function screen gives access to a submenu, the purpose of which is briefly described
below:

MEASURE PROBE.  This will override the normal interval of logging readings to allow
a spot check reading to be obtained on screen.

MEASURE METER PROVER.  Used to test the instrument with the Meter Prover.

VIEW STORED DATA.  Allows visual review of all readings logged.

START DATA LOGGING.  Initiates the data logging process after input of appropriate
start-up data.

ENTER PROBE ID  Allows input of probe type and reading interval.  Together with "SET
TIME AND DATE".  This constitutes initial start-up data.

SET READING INTERVAL.  This allows the initial reading interval that is input under
"PROBE ID" to be changed without deleting stored data.

SET MEASUREMENT TIME.  This allows the initial measurement (polarization) time that is
input under "PROBE ID" to be changed without deleting stored data.

SET TIME AND DATE.  This constitutes the initial step of start-up data, allowing correct
setting of the “real time” clock.

UPLOAD TO MS1500L.  This activates the download of stored data to the MS1500L or to
a personal computer.

UPLOAD TO PC.  This activates the download of stored data to a personal computer.

SYSTEM SHUTDOWN.  This will stop the logging process, and minimize power
consumption without deleting stored data.

TEST MODE.  This allows a calibration check of the 4-20mA loop, and supplies instrument
trouble shooting data.
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The screen of the instrument is initially activated by pressing either key.  The “SET TIME & DATE”
function screen is then accessed by scrolling through the main menu using KEY 1.  KEY 2 allows entry
into the submenu, and the time and date setup screen will be shown.  Each digit of the time, day, month,
and year is sequentially set using KEY 1 to select the appropriate digit, and KEY 2 to enter the digit and
move the next digit of the time and date sequence.

Once the final digit of the year is entered, using KEY 2, the screen will automatically change to the time/
date display screen. This screen shows the time and date as set up.  KEY 2 will accept and store this
time and date.  KEY 1 will reject this information.  Either key will automatically return the user to the
“MEASURE PROBE” screen of the main menu.   If the time and date has been rejected, scroll to the
“SET TIME & DATE” function screen, re-enter the submenu and make the necessary corrections.  If
the time and date are correct, and the user has used KEY 2 to accept the information, scroll to the
“ENTER PROBE ID” function screen to continue with program setup.

Please note that the time and date, once set, should not require alteration except after battery
replacement.  Should the user decide to change the time and date while probe data is stored in
memory, all data will be displaced in time and highly inconvenient to interpret.

B. Program Setup

Having installed the batteries, the MS3500L is ready for start-up programming which compromises the
following sequence:

• SET TIME AND DATE
• ENTER PROBE ID
• START LOGGING

1.Set Time and Date
This operation is illustrated below:
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2. Enter Probe ID

This function will allow the user to identify the particular probe type or installation location with a unique,
4-digit tag number. Additionally, it allows the selection of the desired measurement type. Finally, it allows
the user to select the data collection rate.  The operational sequence is as follows:

Once the “ENTER PROBE ID” function screen is located on the main menu, KEY 2 will give access to
the submenu.  The initial screen of the submenu allows deletion of any stored data.  Normally there will
be no data stored, since any useful data set will have been previously downloaded.  If no useful data is
stored in the unit, press KEY 1 which will delete all existing data and give access to the Probe ID
screen.  If useful data is stored, use KEY 2 to return to the main menu and download existing
data (p. 19) prior to proceeding.

The  Probe  ID  screen  allows  you  to  insert  a 4-digit identification number for the probe and/or
monitoring location. Each digit is selected with KEY 1, and individually entered with KEY 2.  When the
fourth digit of the ID number is entered, the screen will automatically change to the “measurement type”
selection screen.

The measurement ID screen allows the user to select the measurement type by using the “ARROW”
keys to scroll, and the “ENTER” key to select.  The measurement types that are selectable are:

LPR3A: 3-electrode, linear polarization (corrosion rate)
using anodic polarizing current

LPR3C: 3-electrode, linear polarization (corrosion rate)
Using cathodic polarizing current

LPR2: 2-electrode, linear polarization (corrosion rate)

GALV: 2-electrode, zero-resistance, current measurement

POT.: 2-electrode potential measurement
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Upon entry of the probe element ID, the screen will automatically change to the cycle time screen.  This
allows the user to select the cycle time with which the probe will read.  This can be set in increments
from one minute to 15 minutes. KEY 1 is used to increase cycle times, KEY 2 is used to enter the
selected cycle time.  The reading frequency is next set on the screen as hours (two digits) and minutes
(two digits).  The default reading is 1 per hour.  Each digit is selected by a KEY 1 scroll, and individually
entered with KEY 2.  Once the last minute digit is entered, the next screen will be displayed which
shows the reading frequency as entered, which can then be accepted (KEY 2) or rejected (KEY 1).  If
accepted, the screen will revert to the “MEASURE PROBE” function screen, and the user can proceed
to the “START DATA LOGGING” function.  If rejected, the screen will also revert to the “MEASURE
PROBE” function screen, but the user is now required to access the “PROBE ID” function and reset/
correct the probe ID, the element ID, and the reading frequency prior to commencing with the data
logging process.

3.  Start Data Logging
This is the simple sequence of commands that sets the logging process in motion:

The submenu is entered from the “START DATA LOGGING” main menu function screen, using KEY
2.  The first submenu screen is the “SYSTEM READY” screen, from which KEY 2 will start the logging
process and shut down the screen for power conservation.  If, for any reason, the user does not wish to
commence logging, KEY 1 will allow escape to the “MEASURE PROBE” screen of the main menu.

Once  logging  is  activated,  it will  continue until  the  user activates the system shutdown routine, or the
batteries discharge. In either event, all data collected to this point will be retained, but no additional data
will be collected.  Entering a new probe ID will also stop the logging process and eliminate all existing
probe data from the memory. Prior to entering new probe ID, ensure that all useful data is
downloaded.

Should logging continue in an uninterrupted fashion until the memory capacity of the unit is full,  addi-
tional data will sequentially overwrite the initial data points stored in memory.

The user should always set a download schedule of sufficient frequency so that no more than
3,100 readings are taken between download operations.
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C.  Measure Probe Function

The “MEASURE PROBE” function allows the user to make a spot-check probe reading at any time,
without constraint of the normal logging interval.  The submenu sequence is illustrated below:

The first screen of the “MEASURE PROBE” submenu displays the probe I.D. number and
measurement type.  KEY 1 exits to the main menu “MEASURE PROBE” function screen and KEY 2
will activate a measurement.

If KEY 2 is used to activate a measurement, the second submenu screen will be shown that displays the
probe I.D. and test mode, and a “PLEASE WAIT” notation. After approximately 5 minutes, the reading
will be complete and the third submenu screen will be automatically displayed.  This screen will show
the current corrosion rate in MPY, and will give a KEY 1 EXIT option, and a KEY 2 ENTER (save)
option.  KEY 1 will return the user to the “MEASURE PROBE” function screen, KEY 2 will save the
probe reading and automatically display the fourth submenu screen.
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D.  View Stored Data Functions

This facility allows all data stored in the MS3500L to be called up on the screen for review.  The
submenu sequence is shown below:

After pressing either key to access the MS3500L screen, KEY 1 is used to scroll to the “VIEW
STORED DATA” function screen.  KEY 2 is then used to enter the submenu.

Previous readings may be accessed sequentially using KEY 2.  KEY 1 will exit the review screen, and
display metal loss (MILS) and average corrosion rate (MPY) for the reading dis-played when the exit
key is used.  The metal loss/corrosion rate screen will display for approx-imately 30 seconds before
automatically returning to the “MEASURE PROBE” function screen.

The “VIEW STORED DATA” function may be used at anytime without disrupting normal logging.
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E. Set Reading Interval Function

This function permits the reading interval to be changed at any time during logging without disrupting the
logging process or deleting the stored data.  The operation sequence is as follows:

After any key is used to activate the screen, KEY 1 is used to scroll to the “SET READING INTER-
VAL” main function screen.  KEY 2 then allows entry into the submenu.

The current reading interval is displayed as hours and minutes.  Individual digits may be altered using
KEY 1, and entered using KEY 2.  After the final hour digit is entered, the screen will automatically
change to a reading interval confirmation screen.  The interval as entered is displayed.  KEY 1 will exit
to the “MEASURE PROBE” main function screen without entering (saving) the new interval.  KEY 2
will enter (save) the new reading interval, then automatically return to the “MEASURE PROBE” main
function screen, further logging takes place at the new reading interval.



16

F. Downloading Data
Data stored in the MS3500L/3510L unit may be downloaded, via the Opti-Link port, directly to a PC.
Alternatively, data may be downloaded to Metal Samples’ MS1500L Hand-Held Data Logger, and
subsequently transferred to a PC. Direct downloading is usually preferred in a control room or
laboratory environment. Where several MS3500L/3510L units are distributed in a field environment, the
data is most conveniently transferred via the MS1500L to a PC. The MS1500L will accept data from
as many as one hundred MS3500L/3510L units for subsequent transfer to a PC.

1. Upload to PC
To transfer data to a PC it is necessary to install the Corrosion Data Management Software.
To run the Corrosion Data Management Software, you need a PC that meets the following
requirements:

• Pentium® class processor
• Windows® 95 or higher operating system
• 16 MB of RAM
• 10 MB of available hard-disk space
• VGA monitor with 800  600 or greater resolution
• Mouse or pointing device recommended
• Available 9-pin serial port or USB port
• CD-ROM drive for software installation

To install the Corrosion Data Management Software:

1. Insert the setup disk provided in your accessory kit.

2. You will be prompted to close any open programs.  After you have done so, click OK to
continue.
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3. Click the install button to begin installation.  Note, it is recommended that you install the soft-
ware in the default directory.

4. After clicking the install button, the software will be installed on your PC.

5. When the software installation is complete you should remove the setup disk, then reboot your
computer.

Instrument Download Center

The Instrument Download Center is a simple tool for retrieving data from Metal Samples ER and LPR
data logger instruments.

To download data from an instrument:
• Connect the instrument to an available PC serial port or USB port (see page 7.)
• Turn the MS3500L on.
• Run the Corrosion Data Management Software
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• Open the Instrument Download Center
• Select the serial port and instrument
• Click the Download button (ensure that Part Status toggles to “On”).
• From the main menu of the instrument, select UPLOAD TO PC.

Data will begin to transfer from the instrument to the PC, and will appear in the data window of the
Instrument Download Center as shown above.  If the data appears garbled, the wrong instrument type
has been selected.  Select another instrument type and try again.  If data does not appear in the data
window at all, verify that:

• The instrument is connected to a valid serial  or USB port
• All cables are securely connected
• The message “Port Status:  On” appears in the status bar
• There are no errors on the instrument
• If using a USB adapter, ensure that the device drivers have been installed.

Selecting a Serial Port

Use the Serial Port selection box to select the port to which the instrument is connected.  If the COM
port number is unknown, it can be found in Windows Device Manager under “Ports (COM & LPT)”.

Selecting an Instrument

Use the Instrument option box to select the model of Metal Samples instrument being downloaded.
This sets the appropriate communication parameters, which will be displayed in the status bar at the
bottom of the window (“9600,N,8,1” for an MS1500, “2400,N,8,1” for an MS3500).

Downloading Data

To toggle the selected port on and off, click the Download button.  Toggling the port on and off will
also clear the data window.

Once a valid serial port and instrument have been selected, click the Download button to turn the port
on and enable the computer to receive data.  If a valid serial port has been selected, the status bar at the
bottom of the window will display the message “Port Status:  On”.  If an invalid serial port has been
selected, an error message will appear, and the status bar will display the message “Port Status:  Off”.
If this happens, another serial port should be selected.
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Saving Data
To save the data in the data window, click the Save button.  The data is comma-delimited ASCII text.
It can be saved to a standard text (.txt) file, or it can be saved to a comma-separated values (.csv) file,
which greatly simplifies the process of importing the data into some spreadsheet programs such as
Excel® or Quattro Pro®.

Printing Data
To print the contents of the data window, click the Print button.  A print dialog box will be displayed to
allow printer selection and setup.

Charting Data
To chart the contents of the data window, click the Chart Data button.  If the data has not yet been
saved, the user will be prompted to do so before the charting process begins.  For more information on
charting data, see the Data Analysis section.

Data Analysis

The Data Analysis utility is a convenient tool for charting data from Metal Samples ER and LPR data
logger instruments.  The Data Analysis utility can be opened from the Main Menu, or it can be opened
directly from the Instrument Download Center.

If the Data Analysis utility is opened from the Instrument Download Center, the contents of the data
window will be loaded into the chart.  However, if the Data Analysis utility is opened directly from the
Main Menu, a valid data file must be loaded.  The Select File box will open to allow selection of a data
file.
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Loading a Data File

After selecting a data file (or clicking the Chart Data button from the Instrument Download Center) a
status window will display the progress of the file being opened, along with the Instrument Type, Probe
Type, and Probe ID for the data file.

Data Table

After a file has been successfully loaded, the data will be displayed in the Data Table for review.  By
default, all data points will be included in the chart.  However, data points can be turned off, or ex-
cluded, from the chart.  If the “Excluded” flag appears in the status column for a data point, that data
point will not appear in the chart.  To toggle the exclude/include status of a data point, double-click the
data point, or select the data point and click Exclude/Include in the Options menu.

Printing Data

The data table can be printed by clicking Print in the Options menu.  A print dialog box will be dis-
played to allow printer selection and setup.
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Creating A Chart

To chart the selected data, click the Chart Data button, or select Chart Data from the Options menu.
The chart will be displayed in a new window.

Printing a Chart

A chart can be printed using the Print Chart option in the File menu.  A print dialog box will be dis-
played to allow printer selection and setup.

Exporting a Chart

A chart can be exported to other applications using the Copy Chart option in the File menu.  This will
copy both the chart and the raw data to the Windows® Clipboard.  The chart can then be inserted into
other applications using the Paste function.  Note:  In some applications, using the Paste function will
insert the raw data instead of the chart.  In this case, use the Paste Special function, then select Picture

to insert the chart.

Chart Tools

• Statistical Data

The Statistical Data tab at the bottom of the Data Chart window will display a page with statistical
information about the chart data.  If the Statistical Data page is visible, this information can be
printed by clicking Print Statistical Data in the File menu.
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• Finding A Data Points Value

While viewing the chart, the value of any data point can be determined by simply clicking it.  The
value will be displayed in the charts tool-tip box (a small text box that is displayed near the mouse
pointer).  If the tool-tip box does not appear immediately after clicking the data point, hold the
mouse pointer stationary over the chart background for a moment.

• The Tools Menu

The Tools menu contains a collection of utilities for viewing and manipulating the chart.  The Tools

menu can be accessed by clicking Tools on the menu bar, or by right-clicking anywhere on the
chart.

o Data Markers

Show Data Markers toggles the data markers on and off.

o Mean Value

Show Mean Value toggles the mean value line on and off.
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o Trend Line

Show Trend Line toggles the trend line on and off.

o Title/Footnote Setup

Title/Footnote Setup displays a window that allows the chart title and footnotes to be
toggled on and off, and to be modified.

o Plot Setup

Plot Setup displays a window that allows configuration of Y-axis scaling, and of the chart
type.

The Y-axis can be scaled to default values by checking the Auto Scaling option box.  The
Y-axis can be scaled to manual values by un-checking the Auto Scaling box, then entering
the desired values in the Minimum and Maximum fields.

The chart type can be set to Line Chart, Bar Chart, or Area Chart by selecting the
appropriate button in the Chart Type box.  The default chart type is Line Chart.

o Data Series Color

Data Series Color displays a color selection box, which allows the user to select the brush
color for the plot line.  The default color for the plot line is Blue.

o Zoom In

Zoom In allows a region of the chart to be enlarged so that it may be viewed in greater
detail.  To enlarge a region of the chart, click on the two data points that define the left and
right boundaries of the region.

In zoom mode, the mouse pointer will change to a cross-hair.  When zoom mode ends, the
mouse pointer will return to its normal state.

To cancel zoom mode, click Cancel Zoom In from the Tools menu, or simply press the Esc

key.
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o Zoom Out

Zoom Out restores the initial view of the chart, which displays the full data set.

o Calculate Corrosion Rate

If the chart contains ER data, the Calculate Corrosion Rate option will become available
under the Tools menu.  This option allows the corrosion rate to be calculated between any
two data points on the chart.  To calculate the corrosion rate click Calculate Corrosion

Rate, then click two data points.  The corrosion rate between those two data points will be
displayed.
In calculate mode, the mouse pointer will change to an arrow/question mark.  When
calculate mode ends, the mouse pointer will return to its normal state.

To cancel a calculation, click Cancel Calculate from the Tools menu, or simply press the
Esc key.
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2. Upload to MS1500L

The user must first connect the IN3500-2 cable between the Optilink™ connector on the MS3500L
and the phone jack connection on the MS1500L.

Once the communication connection is made between the MS3500L and the MS1500L instruments,
switch on the MS1500L and select a probe ID that corresponds to the probe ID of the MS3500L in
question.  The user must now scroll to the communication menu on the MS1500L and press enter.

The MS1500L communications submenu has the following screen sequence for MS3500L download
operations:

*Before executing this command, set MS3500L to “Waiting for Link Up” mode.

After  selecting  the MS3500L “DOWNLOAD” option on the MS1500L communications menu, the
communications mode should be selected on the MS3500L instrument.  This is achieved by scrolling
through the main functions menu, using KEY 1, until the “UPLOAD TO MS1500L” screen is reached.
The submenu is accessed using KEY 2.  The MS3500L screen will now display “WAITING FOR
LINK UP”, and a KEY 1 exit option. The MS3500L is now waiting for the download instruction from
the MS1500L.  This  instruction is given by pressing enter on the MS1500L unit.  The MS1500L screen
will now display the probe ID and type for the MS3500L in question, plus an option to use “EXIT” to
abort the transfer.  Data transfer is now in progress.

Upon completion of data transfer, the MS3500L screen will display “TRANSFER COMPLETE” and
the MS1500L screen will automatically exchange the “EXIT TO ABORT” option for “ENTER TO
CONTINUE” option. At this point the MS1500L can be disconnected, and the user may download
data  from the next MS3500L or upload data from the MS1500L to the PC.
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G. System Shutdown Function

This function allows the user to suspend the logging process for any period of time without data
loss. The menu screen sequence to operate the function is as shown below:

To activate the system shutdown function, the user should scroll through the main function screens using
KEY 1 until the “SYSTEM SHUTDOWN” function screen is reached.  The user can now use KEY 2
to access the submenu.  The screen will now ask for confirmation.  KEY 2 will activate system
shutdown; KEY 1 will return the user to the main function screens.  If KEY 2 is used to activate
“SYSTEM SHUTDOWN”, data logging will cease but all existing data will be retained in memory.

When the user wishes to reactivate the logging process, either key can be used to access the screen,
and KEY 1 will then resume the logging process.

H.  Test Mode Function

The test mode function is used for factory trouble shooting of faulty instruments returned for repair and
in initial quality assessment of newly manufactured instruments. This function is not required for
normal instrument operation.
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Appendix A - MS3500L Specifications

Model
MS3500L - Remote LPR Data Logger (Ordering # IN3500L)
MS3510L - Remote LPR Data Logger w/ 4-20mA Current Loop Output (Ordering # IN3510L)

Physical Data
Instrument Weight: 11.94 lb. (5.42 Kg)
Total Weight w/ Accessories: 13.64 lb. (6.19 Kg)
Instrument Dimensions: 11.50"H x 8.94"W x 4.00"D (29.21cm x 22.71cm x 10.16cm)
Case Specifications: NEMA 4X (IP 66)
Mounting Specifications: 10.75"H x 6"W (27.31cm x 15.24cm) Bolt Pattern

0.3" (0.76cm) Diameter Bolt Holes
Operating Temperature: 32° to 122°F (0° to 50°C)
Storage Temperature: -4° to 158°F (-20° to 70°C)

Performance Data

Electrical Data
Power Requirements: Six 1.5V AA Batteries
Standard Probe Cable Length*: 10 ft (3.05 m)
Output Specifications: RS-232 Output in Comma-Delimited ASCII Text Format

4-20mA Current Loop Output (MS3510L Only)
Intrinsic Safety: Class I, Division 1

Groups A, B, C, and D
Temperature Code T3
Class I, Zone 0,
Group IIC, T3
Conforms to ANSI/UL Std. 913

Special Features
• Microprocessor-based electronics
• Data storage capacity of 3000 readings, with battery backup
• Menu-driven interface using a 2-key keypad and a 2-line LCD display
• Low-battery detection

Accessory Items
10' Probe Cable, Meter Prover, 6 to 5-Pin Adapter, Galvanic Adapter, Communications Cable and
Connector, Current Loop Connector (MS3510L only), Operation Manual, Corrosion Data Management
Software

* Please contact Metal Samples for longer probe cable lengths.

epyTtnemerusaeM egnaR noituloseR emiTelcyC

edortcelE-2 ypm002ot0 ypm10.0 srh99otnim1

edortcelE-3 ypm051ot0 ypm10.0 srh99otnim1

cinavlaG Aµ999± Aµ1 srh99otnim1

laitnetoP Vm999± Vm1 srh99otnim1
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Appendix B - Derivation of Alloy Constant
The variation of the Stern Geary equation, relating the corrosion current i

cor
, to the polarization resistance

 E/  I is given by:

..........   (1)

which reduces to:

i
cor

=   K  I  ...............................    (2)

i
cor

=  current due to corrosion (amps)
 E =  applied polarizing voltage (volts)
 I =  measured polarizing current (amps)

B
a
+B

c
=  rate constants (volts/decade)

K =  constant (dimensionless)

To convert the polarizing current to the conventional MPY (“MILS PER YEAR”) units of corrosion,
Faraday’s laws are applied as follows:

...................... (3)

...................... (4)

...................... (5)

S =  number of seconds in one year
F =  Faraday’s constant (coulombs)
A =  working electrode surface area in cm2

E =  equivalent weight of corroding metal (gms)
d =  density of corroding metal (gms. cm-3)
C =  corrosion rate (mpy)
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Consequently, when the instrument calculates the corrosion rate (mpy) from the measured polarizing
current (  I), a means needs to be found whereby the instrument can “know” the appropriate value of
E/d, and perform the correct calculation of corrosion rate.  This is achieved in the conventional, three-
electrode LPR measurement by varying the surface area of working electrode in proportion to the E/d
value of the metal/alloy in question, thus avoiding the need to program special correction factors into the
instrument for each and every alloy.

Unfortunately, the major producer of the two-electrode probe uses a constant surface area for the
working electrode, irrespective of the metal/alloy under examination.  Thus a correction factor has to be
applied for each metal/alloy under consideration.  This is, in fact, the alloy constant used for two-
electrode corrosion rate measurements in the MS1500L unit.  The basic formula for derivation of the
correction factor is:

A
k

= 0.55 x E
     d            ............................   6

A
k

=  alloy constant
E =  equivalent weight of metal/alloy in question (gms)
d =  density of alloy in question (gms. cm-3)

For pure metals, if the appropriate alloy constant does not appear in the MS1500L memory already, the
user can apply equation 6 to calculate, and program, the appropriate alloy constant into the instrument
memory.

Difficulties arise when trying to work out the equivalent weight of alloys.  This is approached by use of a
weighted average, assuming all major metallic constituents corrode in proportion to their weight percent
for the alloy in question.   In general,  metallic constituents present in amounts smaller than 1% are
disregarded for the purposes of this calculation.  An example of this is given below for AISI 302
Stainless Steel.

Element Percent Eq. Wt. Eq. Wt. x Percent
Chromium   18 17.34   3.12

Nickel    9 29.35   2.64

Iron   73 27.92 20.39

Alloy Eq. Weight = 26.15
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UNS Constant Table

The following lists many of the common constructional metals/ alloys with their appropriate alloy con-
stants.  All of these values are already programmed into the MS3500L memory.  Additional alloy
constants can be added by the user, applying the calculation principles outlined previously, and with
reference to the Table of Equivalent Weights on p. 32.

Alloy Alternate Major Constituents
UNS# Const. Designation (or common names)

F12101 1.0 - Gray Cast Iron

F13502 1.0 - Gray Cast Iron

G10100 1.0 AISI 1010 0.1% Carbon Steel

G10180 1.0 AISI 1018 0.18% Carbon Steel

G10200 1.0 AISI 1020 0.20% Carbon Steel

K03504 1.0 ASTM A105 0.35% Carbon Steel

K03006 1.0 ASTM A106 0.3% Carbon Steel

K02504 1.0 ASTM A53 0.25% Carbon Steel

K03011 1.0 ASTM A350LF2 0.3% Carbon Steel

K01800 1.0 ASTM A516 0.18% Carbon Steel

G41300 1.0 AISI 4130 1% Cr 0.2% Mo Steel

K41545 1.0 ASTM A199 5% Cr 0.5% Mo. Steel

S50400 1.0 ASTM A199 (T9) 9% Cr 1.0% Mo. Steel

S30400 1.0 AISI 304 18% Cr  8% Ni S.S.

S30403 1.0 AISI 304L 18% Cr 8% Ni (Low Carbon) S.S.

S31600 1.0 AISI 316 18/Cr 10/Ni/ 3/Mo S.S.

S31603 1.0 AISI 316L " (Low Carbon) S.S.

S32100 1.0 AISI 321 Ti Stabilized 18/8 S.S.

S41000 1.0 AISI 410 12% Cr. S.S.

S43000 1.0 AISI 430 17% Cr. S.S.

S31200 1.0 ASTM A182 26 Cr 6 Ni Duplex SS

S31803 1.0 ASTM A276 22 Cr 5 Ni 3 Mo. Duplex S.S.

C11000 2.0 AMS 4500 99.90 Copper

C26000 1.8 AMS 4505 70-30 Brass

C28000 1.8 ASME SB111 Muntz Metal (60% Cu)

C23000 1.9 ASME B16.22 85-15 Brass
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Alloy Alternate Major Constituents
UNS# Const. Designation (or common names)

C63000 1.9 AMS 4640 Aluminum Bronze

C68700 1.9 ASME SB111 Aluminum Brass (Arsenical)

C44300 1.8 ASME B111 Admiralty Brass

C70690 1.9 ASTM F96 90-10 Copper Nickel

C71590 1.6 ASTM F96 70-30 Copper Nickel

N04400 1.2 AMS 4544 Monel 400

N08825 1.0 ASME B163 Incoloy 825

N06600 1.0 AMS 5540 Inconel 600

N06625 1.0 AMS 5401 Inconel 625

N10001 1.0 AMS 5396 Hastelloy B

N10002 1.0 AMS 5388 Hastelloy C

N10276 1.0 ASME B366 Hastelloy C-276

N02201 0.9 AMS 5553 Nickel 201

N08904 1.0 ASME B625 23-1-4-25 Cr-Cu-Mo-Ni

Z13001 1.3 ASTM B6 99.990 Zinc

R05200 0.6 ASTM B364/365 Tantalum

R50250 0.7 ASTM F67 Titanium

R60701 1.0 ASTM B493 Zirconium

A96061 0.9 AA6061 Aluminum
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Table of Equivalent Weights

Name Symbol Atomic Wt. Valence Equivalent Wt.
Actinium Ac (227)

Aluminum Al 26.98 3 8.99

Americium Am 243

Antimony Sb 121.76 3 40.58

Arsenic As 74.92 3 24.97

Barium Ba 137.36 2 68.68

Berkelium Bk (247)

Beryllium Be 9.013 2  4.51

Bismuth Bi 208.99 3 69.66

Cadmium Cd 112.41 2 56.20

Calcium Ca 40.08 2 20.04

Cerium Ce 140.13 3 46.71

Cesium Cs 132.91 1 132.91

Chromium Cr 52.01 3 17.34

Cobalt Co 58.94 2 29.47

Columbium, See Niobium

Copper Cu 63.54 1 63.54

Curium Cm (247) 3 82.33

Dysprosium Dy 162.51 3 54.17

Erbium Er 167.27 3 55.75

Europium Eu 152.0 2 76.0

Francium Fr 223 1 223

Copper Cu 63.54 1 63.54

Curium Cm (247) 3 82.33

Dysprosium Dy 162.51 3 54.17

Erbium Er 167.27 3 55.75

Europium Eu 152.0 2 76.0

Francium Fr 223 1 223

Gadolinium Gd 157.26 3 52.42

Gallium Ga  69.72 2 34.85

Germanium Ge  72.60 4 18.15

Gold, Arum Au 197.0 3 65.66

Hafnium Hf 178.50 4 44.62

Holmium Ho 164.94 3 54.98
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Name Symbol Atomic Wt. Valence Equivalent Wt.

Indium In 114.82 3 38.27

Iridium Ir 192.2 3 64.06

Iron Fe 55.85 2 27.92

Lanthanum La 138.92 3 46.30

Lead, Plumbum Pb 207.21 2 103.6

Lithium Li 6.94 1 6.94

Lutetium Lu 174.99 3 58.33

Magnesium Mg  24.32 2 12.16

Manganese Mn 54.94 2 27.47

Mercury Hg 200.61 1 200.6

Molybdenum Mo 95.95 2 47.97

Neodymium Nd 144.27 3 48.09

Neptunium Np (237) 5 47.40

Nickel Ni 58.71 2 29.35

Niobium,

(Columbium) Nb 92.91 5 18.58

Osmium Os 190.2 8 23.77

Palladium Pd 106.4 2 53.2

Platinum Pt 195.09 2 97.55

Plutonium Pu (244) 5 48.80

Potassium K 39.1 1 39.1

Praserodymium Pr 140.92 3 46.97

Promethium Pm (145) 3 48.33

Radium Ra 226 2 113

Rhenium Re 186.22 4 46.55

Rhodium Rh 102.91 3 34.30

Rubidium Rb 85.48 1 85.48

Ruthenium Ru 101.1 3 33.7

Samarium Sm 150.35 2 75.17

Scandium Sc 44.96 3 14.98

Selenium Se 78.96

Silver Ag 107.87 1 107.9

Sodium Na 22.99 1 22.99

Strontium Sr 87.23 2 43.81

Tantalum Ta 180.95 5 36.19
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Name Symbol Atomic Wt. Valence Equivalent Wt.

Technetium Tc (97) 6 16.16

Tellurium Te 127.61 3 42.53

Terbium Tb 158.93 3 52.97

Thallium Tl 204.39 1 204.39

Thorium Th (232) 4 58.0

Thulium Tm 168.94 3 56.31

Tin, Stannum Sn 118.70 2 59.35

Titanium  Ti 47.90 4 11.97

Tungsten 183.86 4 45.96

Uranium U 238.07 4 59.51

Vanadium V 50.95 2 25.47

Ytterbium Yb 173.04 2 86.52
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Appendix C - Returning the Instrument for Repair

If it is necessary to return any Metal Samples instrument for repair, the following procedure is recom-
mended to ensure the fastest possible repair and return cycle. You may contact Metal Samples to verify
that returning the instrument is necessary.

1. If possible, pack the instrument in the original shipping carton. If the original carton is not available,
pack the instrument in a rigid cardboard or wood carton. Surround the instrument with a minimum
of three inches of resilient packing material such as foam rubber or shredded newspaper.

2. Ship the instrument prepaid via air freight or air express to:

Metal Samples
152 Metal Samples Rd.
Munford, AL 36268

3. Contact Metal Samples by telephone (256) 358-4202 or fax (256) 358-4515 and tell them:
a. the name of the airline carrying the instrument
b. the flight number
c. the estimated time of arrival
d. the waybill number and delivery instructions

4. When the instrument is packed, include a copy of the form on the next page, filled in as required to
expedite the repairs.
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Maintenance and Repair Instructions

This form may be photocopied for use when returning instruments to Metal Samples for repair.  Please
fill in all known information.  Enclose a copy of the filled in form with the instrument.

1. Check one:
                Repair this instrument under warranty.
                Repair this instrument regardless of problem or cost of repair.
                Inspect the instrument and advise the customer of the approximate cost of repairs if the
instrument is not covered under warranty.  (Note: This procedure may delay the return of the instru-
ment to you.)

2. Instrument Identification:
Instrument Model #                                              Serial #_________________
Date and Location of Purchase_____________________________________
Company’s Purchase Order # for Original Sale_________________________

3. Return the Instrument to:
Company Name ________________________________________________
_____________________________________________________________

Address/Location ______________________________________________
____________________________________________________________

Telephone Number:____________________________________

4. Description of Trouble: (a clear description of the problem may shorten repair
time)_______________________________________________________
___________________________________________________________
___________________________________________________________

5. Urgency of Repairs: ___________________________________________
___________________________________________________________
___________________________________________________________
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Appendix D - Warranty

Metal Samples warrants that any part of their corrosion rate instruments and accessories which proves
to be defective in material or workmanship within one year of the date of original shipment to Purchaser
will be repaired or replaced, at the option of Metal Samples, free of charge. This warranty does not
cover (1) probe assemblies, (2) items expendable in nature, or (3) items subject to damage from normal
wear, misuse or abuse, or failure to follow use and care instructions.

All damaged items are to be shipped at Purchaser’s expense to and from Metal Samples. Metal
Samples shall have the right to final determination as to the existence and cause of the defect.

The foregoing shall constitute the sole and exclusive remedy of any purchaser of Metal Samples
products for breach of warranty and is exclusive and in lieu of all other warranties, expressed, implied
or statutory, including the implied warranties or merchantability and fitness. In no event shall Metal
Samples be liable for special or consequential damages or for any delay in the performance of this
warranty due to causes beyond its control.

Orders or requests for additional information should be addressed to:

Metal Samples
152 Metal Samples Rd.
Munford, AL 36268
Telephone: (256) 358-4202
Fax: (256) 358-4515
E-mail: msc@alspi.com

The technical information and suggestions contained herein are believed to be reliable, but they are not

to be construed as warranties since conditions of use are beyond our control.
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